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Module 1 
Introduction to Self-Service BI Solutions 

Contents: 
Lesson 1: Introduction to Business Intelligence 2 

Lesson 2: Introduction to Data Analysis 4 

Lesson 3: Introduction to Data Visualization 7 

Lesson 4: Overview of Self-Service BI 10 

Lesson 5: Considerations for Self-Service BI 12 

Lesson 6: Microsoft Tools for Self-Service BI 14 

Lab Review Questions and Answers 17 
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Lesson 1 
Introduction to Business Intelligence 
Contents: 
Question and Answers 3 
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Question and Answers 
Question: How does your organization approach BI? Is this a major part of the corporate strategy? What 
BI solutions does your organization use? Is Excel used as a self-service tool? What do you think are the 
major issues with your organization’s approach to BI? 

 Answer: Answers will vary, depending on the students’ experience. 
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Lesson 2 
Introduction to Data Analysis 
Contents: 
Question and Answers 5 
Demonstration: Importing Data with Power BI Desktop 5 
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Question and Answers 
Question: How much data does your organization gather? Have you noticed an increase in the volume of 
data that you have to work with? Do you have a mix of data sources, such as on-premises databases, 
cloud services, and SaaS providers? 

 Answer: Answers will vary, depending on the students’ experience. 

Demonstration: Importing Data with Power BI Desktop 

Demonstration Steps 
1. Ensure that the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines are running, 

and then log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd.  

2. In the D:\Demofiles\Mod01 folder, run Setup.cmd as Administrator.  

3. In the User Account Control dialog box, click Yes. When prompted that do you want to continue 
this operation, type Y and then wait for the script to finish. 

4. If you do not have a Power BI login, open Internet Explorer, go to 
https://powerbi.microsoft.com/en-us/documentation/powerbi-admin-signing-up-for-power-
bi-with-a-new-office-365-trial, and follow the steps to create an account. 

5. In Internet Explorer, go to https://www.microsoft.com/en-us/download/details.aspx?id=45331, 
and then click Download.  

6. On the Choose the download you want page, select the PBIDesktop_x64.msi check box, and then 
click Next.  

7. In the message box, click Run. 

8. In the Microsoft Power BI Desktop (x64) Setup dialog box, on the Welcome to the Microsoft 
Power BI Desktop (x64) Setup Wizard page, click Next.  

9. On the Microsoft Software License Terms page, select the I accept the terms in the License 
Agreement check box, and then click Next. 

10. On the Destination Folder page, click Next. 

11. On the Ready to install Microsoft Power BI Desktop (x64) page, click Install. 

12. In the User Account Control dialog box, click Yes. 

13. On the Completed the Microsoft Power BI Desktop (x64) Setup Wizard page, clear the Launch 
Microsoft Power BI Desktop check box, and then click Finish. 

14. Close Internet Explorer. 

15. On the desktop, double-click Power BI Desktop. 

16. When the Get Data screen shows, click Get Data. 

17. In the Get Data dialog box, click SQL Server database, and then click Connect. 

18. In the SQL Server database dialog box, in the Server box, type MIA-SQL. In the Database 
(optional) box, type AdventureWorksDW, and then click OK. 

19. In the Access a SQL Server Database dialog box, leave the default settings unchanged, and click 
Connect. 

20. In the Encryption Support dialog box, click OK. 
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21. In the Navigator dialog box, select the FactInternetSales check box.  

22. Click Select Related Tables. Click Edit. 

23. If the Connection Settings dialog box appears, leave Import checked and click OK. 

24. In the Untitled - Query Editor window, in the Queries pane, click FactInternetSales. 

25. Right-click the CarrierTrackingNumber column, and click Remove. 

26. Right-click the CustomerPONumber column, and click Remove. 

27. In the Queries pane, click DimCustomer. 

28. Right-click the Title column, and click Remove. 

29. Right-click the NameStyle column, and click Remove. 

30. Right-click the Suffix column, and click Remove. 

31. Right-click the MaritalStatus column, and click Replace Values. 

32. In the Value To Find box, type M. 

33. In the Replace With box, type Married, and then click OK. 

34. Right-click the MaritalStatus column, and click Replace Values. 

35. In the Value To Find box, type S. 

36. In the Replace With box, type Single, and then click OK. 

37. Right-click the Gender column, and click Replace Values. 

38. In the Value To Find box, type F. 

39. In the Replace With box, type Female, and then click OK. 

40. Right-click the Gender column, and click Replace Values. 

41. In the Value To Find box, type M. 

42. In the Replace With box, type Male, and then click OK. 

43. Click Close & Apply. 

44. Wait until the data has successfully loaded.  

45. In the Fields pane, expand FactInternetSales, and click SalesAmount.  

46. On the Modeling tab, in the Formatting group, click Format: Currency General, point to Currency, 
and then click $ English (United States). 

47. In the Fields pane, right-click DimCustomer, and then click New column.  

48. In the formula bar, type: 

FullName = DimCustomer[FirstName] & " " & DimCustomer[LastName] 

49. Press Enter. 

50. Click Save. Name the file Adventure Works Sales, and save the file to D:\Demofiles\Mod01. 

51. Leave Power BI Desktop open for the next demonstration. 
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Lesson 3 
Introduction to Data Visualization 
Contents: 
Question and Answers 8 
Demonstration: Visualizing Data with Power BI Desktop 8 

  



1-8    Analyzing Data with Power BI 

 

Question and Answers 
Question: Which of the following is not a real chart type? 

(   ) 100% Stacked Bar Chart 

(   ) Line and Column Chart 

(   ) Multirow Card Chart 

(   ) Donut Chart 

(   ) Pie and Line Chart 

 Answer:  

 (   ) 100% Stacked Bar Chart 

 (   ) Line and Column Chart 

 (   ) Multirow Card Chart 

 (   ) Donut Chart 

 (√) Pie and Line Chart 

Demonstration: Visualizing Data with Power BI Desktop 

Demonstration Steps 
1. In Power BI Desktop, in the Fields pane, under DimCustomer, select Gender, and MaritalStatus.  

2. Under FactInternetSales, select SalesAmount. 

3. In the Visualizations pane, click Clustered column chart.  

4. Click Format, and then expand Title. 

5. Change the Title Text to Sales by Gender and Marital Status.  

6. Change Alignment to Center. 

7. In the Fields pane, expand DimProduct, and drag the Color field onto the report canvas to create a 
new table.  

8. Under FactInternetSales, drag the OrderQuantity field onto the new table. 

9. In the Visualizations pane, click Donut chart. 

10. Click Format, and then expand Title. 

11. Change the Title Text to Orders by Color. 

12. Change Alignment to Center. 

13. In the Fields pane, under FactInternetSales, drag the SalesAmount field onto the report canvas to 
create a new column chart. 

14. In the Visualizations pane, click Fields. 

15. In the Fields pane, expand DimDate, and drag the EnglishMonthName to the Axis property. 

16. Grab the resizer on the column chart to widen the chart so that the month names display clearly. 

17. In the Visualizations pane, click Format, and then expand Title. 

18. Change the Title Text to Sales by Month. 

19. Change Alignment to Center. 
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20. Click Save. 

21. Leave Power BI Desktop open for the next demonstration. 
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Lesson 4 
Overview of Self-Service BI 
Contents: 
Question and Answers 11 
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Question and Answers 
Question: Given what you have learned so far in this module, regarding the limitations of managed BI 
and the uptake of self-service BI with all its advantages, do you think there is a future for managed BI?   

 Answer: To some extent, there will always be a need for IT to be involved in BI, as self-service can 
only go so far. IT will still be required to develop, execute and manage the ETL process, design, 
build, and manage the data warehouse, provide access to data, and ensure users only have access 
to the data they need. A developer is still required to write complex queries, and stored 
procedures. 
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Lesson 5 
Considerations for Self-Service BI 
Contents: 
Question and Answers 13 
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Question and Answers 
Question: Discuss the role of the data steward. Does your organization have a data steward? If not, do 
you think one is necessary? Discuss some of the issues your organization faces, that your existing data 
steward manages, or that the addition of one could solve. 

 Answer: Answers will depend on the opinion of the students. 
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Lesson 6 
Microsoft Tools for Self-Service BI 
Contents: 
Question and Answers 15 
Demonstration: Publishing a Report to the Power BI Service 15 
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Question and Answers 
Question: Which of the following is not an Excel power tool? 

(   ) Power Map 

(   ) Get & Transform 

(   ) Power Pack 

(   ) Power Pivot 

(   ) Power View 

 Answer:  

 (   ) Power Map 

 (   ) Get & Transform 

 (√) Power Pack 

 (   ) Power Pivot 

 (   ) Power View 

Demonstration: Publishing a Report to the Power BI Service 

Demonstration Steps 
1. In Power BI Desktop, on the Home tab, click Publish. 

2. If you are prompted to save your changes, click Save. 

3. In the Power BI Desktop dialog box, enter the email address, and then click Sign in. 

4. In the Sign in to your account dialog box, enter the password for your account, and then click Sign 
in. 

5. The report will then be published to the Power BI portal. When the window displays Success, click 
Open 'Adventure Works Sales.pbix' in Power BI to view the report online.  

6. When the browser opens, if you are prompted to Sign in, click Sign in and then enter your Power BI 
credentials, enter your email address and password, and wait for the report to open.  

7. On the Sales by Gender and Marital Status column chart, click Pin visual. 

8. In the Pin to dashboard dialog box, click New dashboard, and type Adventure Works Sales, and 
then click Pin. 

9. On the Orders by Color donut chart, click Pin visual. 

10. In the Pin to dashboard dialog box, click Existing dashboard, in the list click Adventure Works 
Sales, and then click Pin. 

11. On the Sales by Month column chart, click Pin visual. 

12. In the Pin to dashboard dialog box, click Existing dashboard, in the list click Adventure Works 
Sales, and then click Pin. 

13. In the upper-left corner of the window, below the PowerBI icon, click Show the navigation pane. 

14. Under Dashboards, point out the star icon to indicate a new dashboard, and click Adventure Works 
Sales.  
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15. Drag the lower-right corner of the Sales by Month column chart, and expand it so it is as wide as the 
two charts above it. 

16. Close Internet Explorer. 

17. In the Publishing to Power BI dialog box, click Got it. 

18. Close Power BI Desktop. 
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Lab Review Questions and Answers 
Lab: Exploring an Enterprise BI Solution 

Question and Answers 

Lab Review 
Question: Discuss using Power BI Desktop and Power BI Service, compared to using Excel and Excel 
Services in SharePoint. Which do you think is the best, and why? 

 Answer: Answers will vary. 

Question: Has your organization started using Power BI? If not, how easy do you think it will be to 
implement, and convert existing business users from Excel, or other BI solutions? If you have already 
started using it, how do users find the experience compared to the previous solution? 

 Answer: Answers will vary. 
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Module 2 
Introducing Power BI 

Contents: 
Lesson 1: Power BI 2 

Lesson 2: The Power BI Service 5 

Lab Review Questions and Answers 8 
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Lesson 1 
Power BI 
Contents: 
Question and Answers 3 
Demonstration: Creating a Report with Power BI Desktop 3 

  



Introducing Power BI    2-3 

 

Question and Answers 
Question: Which of the following statements is false? 

(   ) You can import data and create reports with the Power BI Desktop app. 

(   ) You can create and share dashboards on the PowerBI.com online portal. 

(   ) You can sign up to PowerBI.com using a Hotmail email account. 

(   ) Data can be imported from an on-premises SQL Server or Azure SQL Database. 

(   ) Data can be imported from Facebook. 

 Answer:  

 (   ) You can import data and create reports with the Power BI Desktop app. 

 (   ) You can create and share dashboards on the PowerBI.com online portal. 

 (√) You can sign up to PowerBI.com using a Hotmail email account. 

 (   ) Data can be imported from an on-premises SQL Server or Azure SQL Database. 

 (   ) Data can be imported from Facebook. 

Demonstration: Creating a Report with Power BI Desktop 

Demonstration Steps 
Create a Report with Power BI Desktop 

1. Ensure the MSL-TMG1, 20778A-MIA-DC and 20778A-MIA-SQL virtual machines are running, log on 
to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod02\Setup.cmd as an Administrator, when prompted click Yes, type Y, and 
then press Enter. 

3. When the script completes, press any key to close the window. 

4. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

5. Open the Demo.ssmssln solution in the D:\Demofiles\Mod02\Demo folder. 

6. In Solution Explorer, open the 1 - Power BI.sql script file. 

7. On the taskbar, click Power BI Desktop. 

8. In the Power BI Desktop window, click Get Data.  

9. In the Get Data dialog box, click Microsoft Azure SQL Database, and then click Connect. 

10. In the SQL Server Database window, in the Server box, type the URL of the Azure server <Server 
Name>.database.windows.net (where <Server Name> is the name of the server you created), and in 
the Database box, type AdventureWorksLT.  

11. Expand Advanced options. 

12. In SQL Server Management Studio, copy the 1 - Power BI.sql query. 

13. In the Power BI Desktop, paste the query into the SQL statement (optional, requires database) 
box, and then click OK. 

14. In the SQL Server database window, click Database. 

15. In the Username box, type Student. 
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16. In the Password box, type Pa$$w0rd, and then click Connect. 

17. The data preview window will appear. Click Load. 

18. If the Connection Settings window opens, leave Import selected, and click OK. 

19. In the Visualizations pane, click Stacked column chart. 

20. In the Fields pane, under Query1, select ProductName and TotalSales. The chart will auto populate. 
Expand the chart control to horizontally show the full names of the products. 

21. In the Visualizations pane, click Format. 

22. Expand Title, and change the Title Text value to Top 10 Selling Products.  

23. Next to Alignment, click the center icon. 

24. Toggle Data labels to be On. 

25. Expand the Data colors list, and choose another color to change the bars on the chart. 

26. On the File menu, click Save As. Name the report Adventure Works Sales, and save to the 
D:\Demofiles\Mod02\Demo folder. 

27. Leave Power BI Desktop and the report open for the next demonstration. 
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Lesson 2 
The Power BI Service 
Contents: 
Question and Answers 6 
Demonstration: Creating a Content Pack 6 
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Question and Answers 
Question: Discuss the benefits of using Power BI in an organization looking to create reports to analyze 
their data. 

 Answer: Power BI has many benefits, including: 

• Quick to create and publish reports. 
• Easy to use UI.  
• Integration with Microsoft Excel. 
• Free, or low cost licensing. 
• Reports and dashboards can be shared between users in the organization. 
• A multitude of data sources, both on-premises and SaaS vendors, can be amalgamated into 

one report. 
• The Q&A feature facilitates the identification of trends and answers to data questions. 
• Power BI is self-service, eliminating the dependency upon a dedicated report developer.   

Demonstration: Creating a Content Pack 

Demonstration Steps 
1. In Power BI Desktop, on the Home ribbon, click Publish. 

2. If you are prompted to save your changes, click Save. 

3. In the Power BI Desktop window, enter the email address for your Microsoft account, and then click 
Sign in. 

4. In the Sign in to your account window, enter the password for your Microsoft account, and then 
click Sign in. 

5. The report will then be published to the Power BI portal. When the window displays Success, click 
Open 'Adventure Works Sales.pibx' in Power BI to view the report online.  

6. When the browser opens, click Sign in, enter your email address and password, Sign in, and wait for 
the report to open in Internet Explorer. 

7. When the report is visible, click Pin Live Page.  

8. In the Pin to dashboard dialog box, click New dashboard. Type Adventure Works Sales in the box, 
and click Pin live. 

9. In the upper left, click Show the navigation pane. The dashboard will appear under the Dashboards 
list.  

10. Click Settings, then click Create content pack. 

11. In the Microsoft AppSource window, click My entire organization.  

12. In the Title box, type Adventure Works Sales.  

13. In the Description box, type Top 10 selling products, and then click Upload. 

14. In the Choose File to Upload dialog box, navigate to D:\Demofiles\Mod02\Demo\Demo, click 
content_pack.png, and then click Open. 

15. Under Dashboards, select Adventure Works Sales. The Reports and Datasets are automatically 
added, and then click Publish. 

    Note: The organizational content packs are a Power BI Pro feature, and so are unavailable 
to the standard trial accounts. 
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16. Click Get Data, and then click My organization. The content pack appears in the list under My 
organization. 
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Lab Review Questions and Answers 
Lab: Creating a Power BI Dashboard 

Question and Answers 

Lab Review 
Question: Self-Service BI empowers business users with the ability to use corporate data to compile 
reports without the dependency on an IT department, or a dedicated report developer. Giving users 
access to live data means they can gain insights into the most up-to-date transactions. Real-time analysis 
is critical to organizations in certain industry sectors. While this is advantageous to the users, you must 
consider the security and performance of your on-premises databases. What tools can you use to ensure 
the safety and performance of your databases? 

 Answer: The security of your SQL Servers is critical. Always ensure that you adhere to your 
organizational policies on only giving users access to permissible data. If users are reporting directly from 
production databases, performance might be affected. Safeguard performance by using views to limit the 
data that is returned, and employ a data steward to check users are sharing, rather than duplicating, 
reports. This will limit the data that is exported to Power BI. 

Question: Discuss the different SaaS providers that your organization uses, and how this data could be 
used in Power BI dashboards. How could this data be combined with data from production databases to 
create greater insights into data? 

 Answer: Answers will vary, depending on the students’ experience. 
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Module 3 
Power BI Data 

Contents: 
Lesson 1: Using Excel as a Data Source for Power BI 2 

Lesson 2: The Power BI Data Model 5 

Lesson 3: Using Databases As a Data Source for Power BI 7 

Lesson 4: The Power BI Service 9 

Module Review and Takeaways 12 

Lab Review Questions and Answers 13 
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Lesson 1 
Using Excel as a Data Source for Power BI 
Contents: 
Question and Answers 3 
Demonstration: Importing Files from a Local Folder 3 
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Question and Answers 
Question: Which of the following file formats is not a compatible data source in Power BI? 

(   ) CSV 

(   ) TXT 

(   ) XML 

(   ) SQL 

(   ) JSON 

 Answer:  

 (   ) CSV 

 (   ) TXT 

 (   ) XML 

 (√) SQL 

 (   ) JSON 

Demonstration: Importing Files from a Local Folder 

Demonstration Steps 
Import Data from an Excel File 

1. Ensure that the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines are running, 
and then log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd. 

2. In the D:\Demofiles\Mod03 folder, run Setup.cmd as Administrator, and then click Yes when 
prompted. 

3. At the command prompt to close the SQL Server Launchpad, type Y, and then press Enter. 

4. When the script completes, press any key to close the window. 

5. On the taskbar, click Power BI Desktop. 

6. In the Power BI Desktop window, click Get Data.  

7. In the Get Data dialog box, click Excel, and then click Connect. 

8. In the Open dialog box, navigate to D:\Demofiles\Mod03\Demo\Files for Import, click Sales.xlsx, 
and then click Open. 

9. In the Navigator window, click Sales to show a preview of the data. Use the horizontal scrollbar to 
display the columns, select the Sales check box, and then click Load. 

10. When the load completes, in the Fields pane, point out the Sales table. Mention that Power BI has 
detected columns that can be used in aggregations, as indicated by the Sum symbol next to the 
column names. 
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Import Data from a CSV File  

1. On the Home ribbon, click Get Data.  

2. In the Get Data dialog box, click CSV, and then click Connect. 

3. In the Open dialog box, navigate to D:\Demofiles\Mod03\Demo\Files for Import, click 
SalesPerson.csv, and then click Open.  

4. In the preview window, drag the lower-right corner to enlarge the window and display more of the 
data. 

5. Click Load. 

6. In the Fields pane, expand the SalesPerson table to show the columns. Mention that the two tables 
from different sources are now available to use together in a report. If the report is published, the 
tables will be part of the same dataset.  

7. Click File, click Save As, name the report Adventure Works Sales, and then save to the 
D:\Demofiles\Mod03\Demo folder. 

8. Leave Power BI open for the next demonstration. 
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Lesson 2 
The Power BI Data Model 
Contents: 
Question and Answers 6 
Demonstration: Creating a Hierarchy 6 
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Question and Answers 
Question: Discuss some of the different data sources that you might use in your organization to import 
data into the data model in Power BI. What problems would you need to overcome? How easy would it 
be to relate the data in tables from different sources? How easy do you think it would be to use data from 
the web within your model? 

 Answer: When importing data from sources such as a database, while data types and 
relationships might already be established, you may find that the volume of data is too great, so 
that you need to write a query or use filters to reduce the size of the data. Data from the web or 
Excel, is unlikely to be correctly typed, so it is best to correct the types used. You might need to 
use bi-directional cross filtering to overcome many-to-many relationships. 

Demonstration: Creating a Hierarchy 

Demonstration Steps 
Creating a Hierarchy 

1. In the Fields pane, under Sales, right-click Country, and then click new hierarchy. The new hierarchy 
column is added. 

2. Right-click Territory, point to Add to Hierarchy, and then click Country Hierarchy. 

3. Right-click State Province, point to Add to Hierarchy, and then click Country Hierarchy. 

4. Right-click City, point to Add to Hierarchy, and then click Country Hierarchy. 

5. Right-click Country Hierarchy, click Rename, type Region Hierarchy, and then press Enter. 

6. In the Fields pane, under Sales, drag the Total Due column to the report canvas to create a new 
chart. 

7. Drag the Region Hierarchy to the Axis in the Visualizations pane. 

8. Resize and move the chart on the canvas so it fills the report canvas.  

9. In the Fields pane, under Sales, click the Total Due column to give it focus. 

Using a Hierarchy  

1. In the top right-hand corner of the chart, click Click to turn on Drill Down. Notice that the arrow 
icon is now black. 

2. Click the United States column in the chart to show the data by Territory. Notice that the chart title 
has changed. 

3. Click the Northwest column, and again, notice that the chart title changes. 

4. Click the Oregon column. Notice that the title of the chart has changed, and the down arrow in the 
top left-hand corner is disabled. 

5. Click the Drill Up icon to return to the State Province level. 

6. Click the Drill Up icon to return to the Territory level. 

7. Click the Expand all down one level in the hierarchy icon to see the Total Due by Country, 
Territory, and State Province. 

8. Leave Power BI open for the next demonstration. 
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Lesson 3 
Using Databases As a Data Source for Power BI 
Contents: 
Question and Answers 8 
Demonstration: Importing Data from SQL Server 8 
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Question and Answers 
Question: True or false? You can use the Power BI Q&A natural language to ask questions of your data 
when using DirectQuery. 

(   ) True 

(   ) False 

 Answer:  

 (   ) True 

 (√) False 

Demonstration: Importing Data from SQL Server 

Demonstration Steps 
Import Data from SQL Server 

1. On the Home ribbon, click Get Data, and then click SQL Server. 

2. In the SQL Server database dialog box, in the Server box, type MIA-SQL, in the Database 
(optional) box, type AdventureWorks, and then click OK. 

3. If you are prompted to enter your credentials, ensure the Windows tab is selected, click Use my 
current credentials, and then click Connect. If you see the notice regarding unsupported encryption, 
click OK. 

4. In the Navigator window, select Sales.vSalesPerson to preview the data, and ensure the box is 
selected. 

5. Select Sales.vStoreWithDemographics to preview data, and ensure the box is selected, and then 
click Load. 

Import Data Using a Query 

1. On the Home ribbon, click Get Data, and then click SQL Server. 

2. In the SQL Server database dialog box, in the Server box, type MIA-SQL, in the Database 
(optional) box, type AdventureWorks. 

3. Expand Advanced options, and in the SQL statement (optional, required database) box, type 
SELECT * FROM [Production].[Product], and then click OK. 

4. In the MIA-SQL: AdventureWorks window, a preview of the data is displayed. Click Edit. 

5. In Query Editor, in the ProductSubcategoryID column, click the filter icon, and then click Remove 
Empty. 

6. In the Queries pane, right-click Query1, click Rename, type Products, and then click Close & Apply. 
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Lesson 4 
The Power BI Service 
Contents: 
Question and Answers 10 
Demonstration: Querying Data by Using Q&A 10 
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Question and Answers 
Question: How could your organization use content packs and groups? What are the major advantages 
of content packs and groups? 

 Answer: Answers depend on the students’ ideas for using content packs and groups within their 
organization. 

Content packs are useful for bundling related dashboards, reports, and datasets into a package 
that is easy to share and consume. Content packs can be based on departments such as 
manufacturing, sales, or finance, and each can have their own set of relevant data and key 
performance indicators (KPIs). Using an icon for each content pack helps users to quickly identify 
the pack that they need. Content packs can consist of reports and dashboards that are designed 
specifically for mobile devices, or targeted as a specific mobile operating system such as iOS, or 
Windows 10. 

Groups are quick to set up, and they enable members to collaborate on dashboards and reports, 
and communicate though the integration of Exchange services such as calendar, tasks, and 
conversations. Closed groups that are only available to invited members offer security by 
preventing other users from viewing the data contained in the group workspace. 

Demonstration: Querying Data by Using Q&A 

Demonstration Steps 
Ask a Question by Using Q&A 

1. In Power BI Desktop, on the Home ribbon, click Publish. 

2. If you are prompted to save your changes, click Save. 

3. In the Power BI Desktop dialog box, enter the email address for your Microsoft account, and then 
click Sign in. 

4. In the Sign in to your account dialog box, enter the password for your Microsoft account, and then 
click Sign in. 

5. The report will then be published to the Power BI portal. When the window displays Success, click 
Open 'Adventure Works Sales.pbix' in Power BI to view the report online.  

6. When the browser opens, click Sign in, enter your email address and password, click Sign in, and 
then wait for the report to open in Internet Explorer. 

7. When the report is visible, click Pin Live Page. 

8. In the Pin to dashboard dialog box, click New dashboard, type Adventure Works Sales in the box, 
and then click Pin live. If the Introducing Featured dashboard message appears, click Got it. 

9. Click Show the navigation pane, under Dashboards, click Adventure Works Sales. 

10. Click in the Ask a question about your data box, and then point out the list of tables and fields that 
automatically appears.  

11. Type sales person. Q&A returns a list of suggestions. Select sales person by city and the table is 
reordered. 

12. In the Q&A box, type show company name and unit price as pie chart. When the chart is visible, in 
the top-right of the report, click Pin visual.  

13. In the Pin to dashboard dialog box, leave Existing dashboard selected, and then click Pin. 
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14. Click unit price to highlight it, and then scroll down the list of suggestions in the Q&A box, to show 
how Q&A is picking up the columns from the dataset to create suggestions.  

15. Click Show the navigation pane, under Dashboards, click Adventure Works Sales. Scroll down the 
dashboard if necessary, to display the new charts on the dashboard. 

16. Close Internet Explorer. 

17. In Power BI Desktop, in the Publishing to Power BI window, click Got it, and then close Power BI 
Desktop. 
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Module Review and Takeaways 
Review Question(s) 
Question: Discuss the different ways in which Power BI could reduce your organization’s dependency on 
shared Excel files. How would having a central location for data, reports, and dashboards benefit different 
departments? How could each department make use of features such as content packs and the natural 
query language in Q&A? 

Answer: Answers will vary depending on the students’ experience. 
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Lab Review Questions and Answers 
Lab: Importing Data into Power BI 

Question and Answers 

Lab Review 
Question: Discuss the different data sources that your organization could use to create Power BI reports. 
Can you think of a scenario where users perhaps have Excel workbooks for one set of reports, and reports 
in SQL Server Reporting Services for another set of data? Could this be combined into a single dataset in 
Power BI? 

 Answer: Answers will vary depending on the students’ experience. 
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Module 4 
Shaping and Combining Data 

Contents: 
Lesson 1: Power BI Desktop Queries 2 

Lesson 2: Shaping Data 5 

Lesson 3: Combining Data 8 

Module Review and Takeaways 11 

Lab Review Questions and Answers 12 
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Lesson 1 
Power BI Desktop Queries 
Contents: 
Question and Answers 3 
Resources 3 
Demonstration: Using Applied Steps 3 
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Question and Answers 
Question: Which of the following statements about Applied Steps is false? 

(   ) Steps are added in sequential order. 

(   ) You can rename the steps. 

(   ) The Source step is always the first step. 

(   ) The Navigation step only shows if you have selected tables or views from the data source, instead of 
using a query. 

(   ) You can move a step between the Source step, and the Navigation step. 

 Answer:  

 (   ) Steps are added in sequential order. 

 (   ) You can rename the steps. 

 (   ) The Source step is always the first step. 

(   ) The Navigation step only shows if you have selected tables or views from the data source, 
instead of using a query. 

 (√) You can move a step between the Source step, and the Navigation step. 

Resources 

Applied Steps 

    Best Practice: Providing sensible names for the steps in your queries helps if you return to 
the data after a long time, and have forgotten exactly what transformations were applied. This is 
particularly helpful if you want to stop halfway through shaping your data, and return later. You 
can see the list of transformations, and pick up from where you finished before. This will be 
helpful if you share the query with colleagues. 

Demonstration: Using Applied Steps 

Demonstration Steps 
1. If it is not already running, start the MSL-TMG1, 20778A-MIA-DC and 20778A-MIA-SQL virtual 

machines, log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd. 

2. On the taskbar, click Power BI Desktop. 

3. In the Power BI Desktop window, click Get Data.  

4. In the Get Data dialog box, click Microsoft Azure SQL Database, and then click Connect. 

5. In the SQL Server Database window, in the Server box, type the URL of the Azure server <Server 
Name>.database.windows.net (where <Server Name> is the name of the server you created), and in 
the Database box, type AdventureWorksLT, and then click OK. 

6. In the SQL Server database dialog box, click Database. 

7. In the Username box, type Student, in the Password box type Pa$$w0rd, and then click Connect. 

8. In the Navigator window, select SalesLT.SalesOrderDetail, and click Edit. 
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9. On the Ribbon, in the Query group, click Advanced Editor. The window opens to display the query 
code. Note that no transformations have been applied yet. Click Cancel. 

10. Right-click the SalesOrderDetailID column, and click Remove. 

11. In the Applied Steps list, right-click Removed Columns, and click Rename. Type Removed 
SalesOrderDetailID, and then press Enter. 

12. In the center pane, right-click the OrderQty column, and click Rename. Type OrderQuantity, and 
then press Enter.  

13. In the Applied Steps list, right-click Renamed Columns, and click Rename. Type Renamed 
OrderQty, and then press Enter. 

14. In the center pane, click the rowguid column, and with the Ctrl key held down, click ModifiedDate. 

15. Right-click either of the column headings, and then click Remove Columns.  

16. In the Applied Steps list, right-click Removed Columns, and click Rename. Type Removed 
rowguid and ModifiedDate, and then press Enter. 

17. On the Ribbon, in the Query group, click Advanced Editor. The window opens to display the query 
code. Note that the transformations have been added, and they are in the same order as the list of 
Applied Steps. Click Cancel. 

18. In the Applied Steps list, right-click Removed rowguid and ModifiedDate, and click Move Up.  

19. In the Applied Steps list, click the delete icon next to Removed SalesOrderDetailID.  

20. In the Delete Step dialog box, click Delete. The SalesOrderDetailID column reappears in the table.  

21. In the Applied Steps list, click the gear icon next to Navigation.  

22. In the Navigation window, select SalesLT.SalesOrderHeader, and click OK. Note that the data 
preview has been updated with the SalesLT.SalesOrderHeader data. Also note the warning icon 
under Queries [1]. 

23. In the Applied Steps list, click the delete icon next to Removed rowguid and ModifiedDate.  

24. In the Delete Step dialog box, click Delete. 

25. In the Applied Steps list, click the delete icon next to Renamed OrderQty. 

26. Note that the warning is no longer displayed.  

27. On the Ribbon, in the Query group, click Advanced Editor. The window opens to display the query 
code. Note that the transformations have been removed, and the source table has been changed. 
Click Cancel.  

28. On the Ribbon, click Close & Apply to return to Power BI Desktop. 

29. Leave Power BI Desktop open for the next demonstration. 
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Lesson 2 
Shaping Data 
Contents: 
Question and Answers 6 
Resources 6 
Demonstration: Transforming Data with the Query Editor 6 
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Question and Answers 
Question: Which of the following is not good advice for shaping your data? 

(   ) Remove all columns and rows that are not used in the reports. 

(   ) Rename columns to provide names that represent the column data, and can be used by Power BI 
Q&A. 

(   ) Let Power BI guess the data types of your columns because it will always be correct. 

(   ) Create an index column if you want to guarantee the sort order in a visual, or if you are appending 
data. 

(   ) Use the Age function on a Date of Birth column to calculate the current age. 

 Answer:  

 (   ) Remove all columns and rows that are not used in the reports. 

(   ) Rename columns to provide names that represent the column data, and can be used by 
Power BI Q&A. 

 (√) Let Power BI guess the data types of your columns because it will always be correct. 

(   ) Create an index column if you want to guarantee the sort order in a visual, or if you are 
appending data. 

 (   ) Use the Age function on a Date of Birth column to calculate the current age. 

Resources 

Formatting Data 

    Best Practice: The Merge Columns function can be used on address fields to quickly create 
a full address column. Highlight your address columns in order, and click Merge Columns. For 
the separator, choose Custom, and enter “, ” (comma and a space). This concatenates all the 
values together in a comma separated list.  
 
However, you are likely to have null values or empty strings in some columns, perhaps Address2, 
which results in double commas. You can use the Replace Values function on the Any Column 
group of the Transform tab, to replace “, ,”, with “, ”. 

Demonstration: Transforming Data with the Query Editor 

Demonstration Steps 
1. If Power BI Desktop is not already open, click Power BI Desktop on the taskbar. Click Get Data if the 

Get Data dialog box displays. 

2. If Power BI Desktop is already open, click Get Data. 

3. In the Get Data dialog box, click Excel, and then click Connect. 

4. In the Open dialog box, browse to the D:\Demofiles\Mod04\Demo folder, click Sales Matrix.xlsx, 
and then click Open. 

5. In the Navigator dialog box, select Sales, and then click Load. 

6. When the data has finished loading, on the Ribbon, click Edit Queries, and from the drop-down list, 
click Edit Queries. 



Shaping and Combining Data    4-7 

7. In the Untitled - Query Editor dialog box, in the Queries pane, click Sales. 

8. On the Transform ribbon, click Transpose. 

9. Note that the columns are now rows. 

10. Click the table icon in the top left-hand corner of the table, and click Use First Row As Headers. 

11. Right-click the Column1 column, click Rename, type Country, and then press Enter. 

12. Right-click the Column2 column, click Rename, type Category, and then press Enter. 

13. Click the Country column, and on the ribbon, in the Any Column group, click Fill, and then click 
Down. The null values are replaced.  

14. Click the 2005 column, hold down the Ctrl key and click the 2006, 2007, and 2008 columns. 

15. Right-click any of the selected column headers, and then on the ribbon, in the Any Column group, 
click Unpivot Columns. 

16. Note that the names of the columns are Attribute and Value for the attribute-value pairing. 

17. Right-click the Attribute column, click Rename, type Year, and then press Enter. 

18. Right-click the Value column, click Rename, type Sales, and then press Enter. 

19. On the File menu, click Close & Apply. 

20. In the Fields pane, expand Sales, click Country to select the field. 

21. On the Modeling ribbon, click Data Category: Uncategorized. Select Country/Region. 

22. In the Fields pane, note the map icon next to Country. 

23. In the Fields pane, under Sales, click Sales to select the field. 

24. In the Formatting group, click Data Type: Text, and click Fixed Decimal Number.  

25. If a Data type change dialog box appears, click Yes. 

26. Click Format: Currency General, click Currency, and then select $ English (United States). 

27. In the Fields pane, note the sum symbol next to Sales. 

28. Drag the Country field onto the report. Note that Power BI automatically chooses the map chart. 

29. Drag the Sales field onto the map, and note that the bubble sizes now represent the Sales figure. 

30. Click the report canvas. 

31. In the Visualizations pane, click Clustered column chart.  

32. Drag Category onto the Axis property. 

33. Drag Year onto the Axis property. 

34. Drag Country onto the Legend property. 

35. Drag Sales onto the Value property. 

36. Grab the corner edge of the chart to expand the width and height.  

37. Click the Click to turn on Drill Down arrow icon in the top right-hand corner of the chart. 

38. Click the tallest column in the Bikes group. This now breaks down the sales by year. 

39. Save the file report as AdventureWorks Sales.pbix to D:\Demofiles\Mod04\Demo, as this will be 
used for the next demonstration. 
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Lesson 3 
Combining Data 
Contents: 
Question and Answers 9 
Resources 9 
Demonstration: Adding and Shaping Data from the Internet 9 
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Question and Answers 
Question: Which of the following is not a true join type for merging columns? 

(   ) Left Outer (all from first, matching from second). 

(   ) Right Outer (all from second, matching from first). 

(   ) Full Outer (all rows from both). 

(   ) Inner (matching rows only). 

(   ) Random (let Power BI decide). 

 Answer:  

 (   ) Left Outer (all from first, matching from second). 

 (   ) Right Outer (all from second, matching from first). 

 (   ) Full Outer (all rows from both). 

 (   ) Inner (matching rows only). 

 (√) Random (let Power BI decide). 

Resources 

Merging Data 

    Best Practice: If you are appending rows from multiple sources, and the table contains 
index values that overlap when the data is combined, combine the data, and then create a new 
index column on the table into which the rows have been appended. 

Demonstration: Adding and Shaping Data from the Internet 

Demonstration Steps 
1. If Power BI Desktop is not already open, click Power BI Desktop on the taskbar. If the Get Data 

dialog box displays, click Get Data. In the Navigator window, click Web, and click Connect. 

2. If Power BI Desktop is already open, on the Home tab, click Get Data, click Web. 

3. In the From Web dialog box, in the URL box, type http://www.imdb.com/chart/top, and then click 
OK.  

4. In the Navigator window, select Table 0, and click Edit. 

5. In Query Editor, right-click the left-most column, and click Remove. 

6. Right-click the right-most column, and click Remove. 

7. Right-click the Your Rating column, and click Remove. 

8. Note that these steps have been grouped together in the Applied Steps list as Removed Columns. 

9. Click the Rank & Title column, and then on the Home tab, in the Transform group, click Split 
Column, and then click By Delimiter. 

10. In the Select or enter delimiter list, select --Custom--, and type a period (.) in the box.  

11. In the Split section, click At the left-most delimiter, and then click OK. 

12. The Rank data now shows in its own column. Right-click the Rank & Title.1 column, click Rename, 
type Rank, and press Enter. 
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13. Click the Rank & Title.2 column, and on the Transform ribbon, in the Any Column group, click 
Replace Values. 

14. In the Replace Values dialog box, in the Value to Find box, type (, and then click OK. 

15. With focus on the Rank & Title.2 column, from the Any Column group, click Replace Values. 

16. In the Replace Values dialog box, in the Value to Find box, type ), and then click OK. 

17. With focus on the Rank & Title.2 column, in the Text Column group, click Split Column, and then 
click By Number of Characters.  

18. In the Number of characters box, type 4.  

19. In the Split section, click Once, as far right as possible, and then click OK. 

20. The Year data has been moved to a separate column.  

21. Right-click the Rank & Title.2.1 column, click Rename, type Title, and press Enter. 

22. In the Text Column group, click Format, and then click Trim. The white space around the titles is 
removed.  

23. Right-click the Rank & Title.2.2 column, click Rename, type Year, and press Enter. 

24. In the Query Settings pane, under Properties, in the Name box, type IMDB Top 250 Movies, and 
then press Enter. 

25. On the File menu, click Close & Apply. 

26. In Power BI Desktop, on the File menu, click Exit. If prompted to save your changes, click Save. 
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Module Review and Takeaways 
Question: Discuss the benefits of using Power BI, rather than Excel, to shape and transform your data. Are 
there any disadvantages? What can Power BI do that Excel cannot, and vice versa? Which tool do you 
think is most straightforward to use? 

 Answer: Answers will vary, depending on the students’ experience and opinions. 
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Lab Review Questions and Answers 
Lab: Shaping and Combining Data 

Question and Answers 

Lab Review 
Question: Discuss the types of different data in your organization that could be combined using the 
Query Editor. Do you have data stored across locations that could be appended, or lookup data that could 
be merged into other tables to make it more useful for reporting? 

 Answer: Answers will vary, depending on the students’ experience. 
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Module 5 
Modeling Data 

Contents: 
Lesson 1: Relationships 2 

Lesson 2: DAX Queries 6 

Lesson 3: Calculations and Measures 8 

Lab Review Questions and Answers 11 
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Lesson 1 
Relationships 
Contents: 
Question and Answers 3 
Demonstration: Viewing Relationships in Power BI 3 
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Question and Answers 
Question: Which of the following statements is false? 

(   ) The Power BI Autodetect feature works out the cardinality of the relationship between two tables. 

(   ) When querying the data source, Power BI automatically determines the relationships, and creates 
them. 

(   ) The Sales table is related to the Customer table using the CustomerID column. There are many orders 
in the Sales table for each customer, and one row in the Customers table for each customer. This is a 
Many to One relationship. 

(   ) The Employees table has one row for each employee, and is related to the EmployeeAdditionalDetails 
table using the EmployeeID column. There is one instance of each employee in the 
EmployeeAdditionalDetails table. This is a One to One relationship. 

(   ) After Power BI automatically creates a relationship, you cannot change the cardinality or cross filter 
direction options. 

 Answer:  

(   ) The Power BI Autodetect feature works out the cardinality of the relationship between two 
tables. 

(   ) When querying the data source, Power BI automatically determines the relationships, and 
creates them. 

(   ) The Sales table is related to the Customer table using the CustomerID column. There are 
many orders in the Sales table for each customer, and one row in the Customers table for each 
customer. This is a Many to One relationship. 

(   ) The Employees table has one row for each employee, and is related to the 
EmployeeAdditionalDetails table using the EmployeeID column. There is one instance of each 
employee in the EmployeeAdditionalDetails table. This is a One to One relationship. 

(√) After Power BI automatically creates a relationship, you cannot change the cardinality or cross 
filter direction options. 

Demonstration: Viewing Relationships in Power BI 

Demonstration Steps 
1. Run D:\Demofiles\Mod05\Setup.cmd as an Administrator, and, in the User Account Control 

dialog box, click Yes.  

2. When prompted press Y, press Enter, and when the script completes, press any key to close the 
window. 

3. On the desktop, double-click Power BI Desktop.  

4. In the Get Data dialog box, click Get Data. Ensure Excel is selected, and click Connect.  

5. In the Open dialog box, navigate to D:\Demofiles\Mod05\Demo, click Adventure Works Sales 
Data.xlsx, and then click Open. 

6. In the Navigator dialog box, select DimCurrency, DimCustomer, DimDate, DimProduct, 
DimPromotion, DimSalesTerritory, and FactInternetSales.  

7. Click Load. 

8. In the views pane on the left-hand side, click Relationships. 
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9. Point out that Power BI has created the relationships automatically. The layout represents a star 
schema. 

10. Maximize the tables in the relationship diagram to display all columns. 

11. Point out that Power BI has not created a relationship to DimDate from FactInternetSales.  

12. On the Home tab, click Manage Relationships. 

13. In the Manage Relationships dialog box, click New.  

14. In the Create Relationships dialog box, in the top table list, click FactInternetSales. When the table 
preview appears below, click the OrderDateKey column.  

15. In the bottom table list, click DimDate. When the table preview appears below, click the DateKey 
column. 

16. Check that the Cardinality is set to Many to One (*:1), the Cross filter direction is Single, and 
Make this relationship active is selected, and then click OK. 

17. In the Manage Relationships dialog box, click Close. 

18. In the diagram, in the FactInternetSales table, click the DueDateKey column. Drag the DueDateKey 
column to the DateKey column in the DimDate table. Point out the dotted line to show that the 
relationship is inactive. This is because there is more than one related column in the two tables.  

19. In the diagram, in the FactInternetSales table, click the ShipDateKey column. Drag the 
ShipDateKey column to the DateKey column of the DimDate table. Point out the dotted line to 
show that the relationship is inactive. 

20. Point out that the relationships from FactInternetSales to DimCurrency, DimProduct, 
DimPromotion, and DimSalesTerritory, have a cross filter direction of Both, indicated by the double 
arrow icon. These are lookup tables, so should be Single. 

21. On the Home tab, click Manage Relationships.  

22. In the Manage Relationships dialog box, double-click the FactInternetSales (CurrencyKey) 
relationship.   

23. In the Edit Relationships dialog box, in the Cross filter direction list, click Single, and then click OK.  

24. In the Manage Relationships dialog box, double-click the FactInternetSales (ProductKey) 
relationship.   

25. In the Edit Relationships dialog box, in the Cross filter direction list, click Single, and then click OK.  

26. In the Manage Relationships dialog box, double-click the FactInternetSales (PromotionKey) 
relationship.   

27. In the Edit Relationships dialog box, in the Cross filter direction list, click Single, and then click OK.  

28. In the Manage Relationships dialog box, double-click the FactInternetSales (SalesTerritoryKey) 
relationship.   

29. In the Edit Relationships dialog box, in the Cross filter direction list, click Single, and then click OK.  

30. In the Manage Relationships dialog box, click Close. 

31. Click the relationship line between FactInternetSales and DimCustomer. Point out that this is a One 
to One relationship because the FactInternetSales table only contains an extract. Normally this would 
be Many to One. This must be changed so it is ready for the remainder of the data to be loaded later.  

32. Click the relationship line between FactInternetSales and DimCustomer and press Delete. 

33. In the Delete Relationship dialog box, click Delete. 
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34. On the Home tab, click Manage Relationships. 

35. In the Manage Relationships dialog box, click New. 

36. In the Create Relationships dialog box, in the top table list, click FactInternetSales and in the data 
preview, click the CustomerKey column.  

37. In the bottom table list, click DimCustomer, and in the data preview, click CustomerKey.  

38. In the Cardinality list, click Many to One (*:1), and then click OK. 

39. In the Manage Relationships dialog box, click Close.  

40. In the diagram, point out that the 1 icon next to FactInternetSales is now a star icon. 

41. Click Save, and save the file to the D:\Demofiles\Mod05\Demo folder as Adventure Works 
Sales.pbix. 

42. Leave Power BI Desktop open for the next demonstration. 
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Lesson 2 
DAX Queries 
Contents: 
Question and Answers 7 
Demonstration: Row and Filter Context in DAX Formulas 7 

  



Modeling Data    5-7 

Question and Answers 
Question: You want to concatenate and manipulate columns containing string data. Which of the 
following functions will not be compatible for working with text? 

(   ) CONCATENATE 

(   ) MEDIAN 

(   ) REPLACE 

(   ) TRIM 

(   ) UPPER 

 Answer:  

 (   ) CONCATENATE 

 (√) MEDIAN 

 (   ) REPLACE 

 (   ) TRIM 

 (   ) UPPER 

Demonstration: Row and Filter Context in DAX Formulas 

Demonstration Steps 
1. In Power BI Desktop, in the Views list on the left side of the window, click Report.  

2. In the Fields pane, click FactInternetSales. 

3. On the Modeling ribbon, in the Calculations group, click New Measure. 

4. In the formula bar, highlight Measure =, type the following script, and then press Enter: 

TotalSales = SUM(FactInternetSales[SalesAmount]) 

5. In the Fields pane, click FactInternetSales. 

6. Click New Column, and in the formula bar, highlight Column =, and type: 

European Sales = CALCULATE(FactInternetSales[TotalSales], 
DimSalesTerritory[SalesTerritoryGroup] = "Europe") 

7. Point out that the TotalSales measure has been used in the formula, and then press Enter. 

8. In the Fields pane, select the European Sales check box to add it to the report. 

9. In the Visualizations pane, click Gauge, and then click Format. 

10. Expand Gauge axis, in the Max field, type 1000000, and in the Target field, type 1000000. 

11. Leave Power BI open for the next demonstration. 
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Lesson 3 
Calculations and Measures 
Contents: 
Question and Answers 9 
Demonstration: Creating Calculated Columns and Measures with DAX 9 

  



Modeling Data    5-9 

Question and Answers 
Question: Which of the following DAX functions is not suitable for creating a calculated table? 

(   ) UNION 

(   ) SUM 

(   ) CROSSJOIN 

(   ) NATURALINNERJOIN 

(   ) NATURALLEFTOUTERJOIN 

 Answer:  

 (   ) UNION 

 (√) SUM 

 (   ) CROSSJOIN 

 (   ) NATURALINNERJOIN 

 (   ) NATURALLEFTOUTERJOIN 

Demonstration: Creating Calculated Columns and Measures with DAX 

Demonstration Steps 
1. In Power BI Desktop, in the view pane, click Data to open the data view.  

2. In the Fields pane, click DimCustomer to select the table, and preview the data. 

3. Right-click DimCustomer, and click New column.  

4. In the formula bar, highlight Column =, and type:  

FullName = [FirstName] & " " & [LastName] 

5. Press Enter.  

6. If the new column is not visible, scroll to the right of the table. Note the new FullName column in the 
table. In the Fields pane, point out the icon next to the new column, which indicates that this has 
been created using a DAX formula.  

7. In the Fields pane, right-click DimCustomer and click New column.  

8. In the formula bar, highlight Column =, and type: 

MaleFemale = IF([Gender] = "M", "Male", "Female") 

9. Press Enter.  

10. Note the new column at the end of the table. 

11. On the Modeling ribbon, in the Calculations group, click New Column.  

12. In the formula bar, highlight Column =, and type: 

Relationship = IF([MaritalStatus] = "M", "Married", "Single") 

13. Press Enter.  

14. Note the new column at the end of the table. 

15. On the Modeling ribbon, in the Calculations group, click New Table.  
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16. In the formula bar, highlight Table =, and type: 

DimCountry = DATATABLE ( 
"Country", STRING, "Code", STRING, 
{ 
{"United States", "US"}, 
{"United Kingdom", "UK"}, 
{"France", "FR"}, 
{"Germany", "DE"}, 
{"Spain", "ES"} 
} 
) 

17. Click Enter.  

18. In the Fields pane, note the new table. 

19. On the Modeling ribbon, in the Calculations group, click New Measure.  

20. In the formula bar, highlight Measure =, and type: 

MostRecentOrder = MAX(FactInternetSales[OrderDateKey])  

21. Press Enter. 

22. In the Fields pane, note the icon next to the measure, to indicate that this is a calculated field. 

23. In the Fields pane, click the MostRecentOrder field. 

24. On the Modeling ribbon, in the Properties group, click Home Table: DimCountry, and click 
FactInternetSales. This moves the measure so that it resides in the FactInternetSales table.  

25. In the Fields pane, note that the MostRecentOrder measure now appears under FactInternetSales. 

26. Close Power BI Desktop, saving any changes. 
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Lab Review Questions and Answers 
Lab: Modeling Data 

Question and Answers 

Lab Review 
Question: Discuss the functions covered in this topic, or use the link provided in the functions lesson of 
the Dax Queries topic to look online at the DAX Function Reference. How many of these have you already 
used? Have you used the equivalent functions in Excel? Which functions can you use for creating columns 
and measures in your organizational datasets?  

 Answer: Answers will vary, depending on the opinions of the students. 

Question: Look at the dataset you used in the labs. How else can you use DAX formulas to add additional 
columns or create new measures? Do you think there are any gaps in the data that you could fill using 
DAX? 

 Answer: Answers will vary, depending on the opinions of the students. 
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Module 6 
Interactive Data Visualizations 

Contents: 
Lesson 1: Creating Power BI Reports 2 

Lesson 2: Managing a Power BI Solution 6 

Module Review and Takeaways 9 

Lab Review Questions and Answers 10 

  



6-2    Analyzing Data with Power BI 

 

Lesson 1 
Creating Power BI Reports 
Contents: 
Question and Answers 3 
Demonstration: Adding Visualizations to a Report 3 
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Question and Answers 
Question: Discuss some of the charts that you could use to represent your organizational data. What 
types of chart would you use? Would different charts represent the data in different ways? Do you have 
data that would benefit from using a scatter chart, so that you can identify clusters, or outliers? Are there 
any missing chart types in Power BI that you might be able to download from the community gallery to 
fulfill your requirements? 

 Answer: Answers will depend on the students’ experience. 

Demonstration: Adding Visualizations to a Report 

Demonstration Steps 
1. If you do not have a Power BI login, open Internet Explorer, go to 

https://powerbi.microsoft.com/en-us/documentation/powerbi-admin-signing-up-for-power-
bi-with-a-new-office-365-trial, and follow the steps to create an account. 

2. In Internet Explorer®, go to https://www.microsoft.com/en-
us/download/details.aspx?id=45331, and then click Download.  

3. On the Choose the download you want page, select the PBIDesktop_x64.msi check box, and then 
click Next.  

4. In the message box, click Run. 

5. In the Microsoft Power BI Desktop (x64) Setup dialog box, on the Welcome to the Microsoft 
Power BI Desktop (x64) Setup Wizard page, click Next.  

6. On the Microsoft Software License Terms page, select the I accept the terms in the License 
Agreement check box, and then click Next. 

7. On the Destination Folder page, click Next. 

8. On the Ready to install Microsoft Power BI Desktop (x64) page, click Install. 

9. In the User Account Control dialog box, click Yes. 

10. On the Completed the Microsoft Power BI Desktop (x64) Setup Wizard page, clear the Launch 
Microsoft Power BI Desktop check box, and then click Finish. 

11. Close Internet Explorer. 

Connect to a Database in Azure SQL Database and Import Data 

1. Ensure that the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines are running, 
and then log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd. 

2. In the D:\Demofiles\Mod06 folder, run Setup.cmd as Administrator, and then click Yes when 
prompted. If asked Do you want to continue with this operation?, type Y and press Enter. 

3. When the script completes, press any key to close the window. 

4. Start Microsoft SQL Server Management Studio from the taskbar, and then connect to the MIA-SQL 
database engine instance by using Windows® authentication. 

5. In the D:\Demofiles\Mod06\Demo folder, open the Demo.ssmssln solution. 

6. In Solution Explorer, open the 1 - Charts.sql script file. 

7. On the desktop, double-click the Power BI Desktop icon. 

8. In the Power BI Desktop window, click Get Data.  
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9. In the Get Data dialog box, click Microsoft Azure SQL Database, and then click Connect. 

10. In the SQL Server database window, in the Server box, type the URL of the Azure server <Server 
Name>.database.windows.net (where <Server Name> is the name of the server that you created). 

11. In the Database box, type AdventureWorksLT.  

12. Expand the Advanced options box. 

13. In SQL Server Management Studio, copy the query under Customer Address in the 1 - Charts.sql 
query. 

14. In Power BI Desktop, paste the query into the SQL Statement (optional, requires database) box, 
and then click OK. 

15. In the SQL Server database window, click Database, in the Username box, type Student, and in the 
Password box, type Pa$$w0rd, and then click Connect. 

16. The data preview window will appear. Click Load. 

17. The window will close and a blank report canvas will open. 

18. In the Power BI Desktop window, click Get Data. 

19. In the Get Data dialog box, click Microsoft Azure SQL Database, and then click Connect. 

20. In the SQL Server database window, in the Server box, type the URL of the Azure server <Server 
Name>.database.windows.net (where <Server Name> is the name of the server that you created). 

21. In the Database box, type AdventureWorksLT.  

22. Expand the Advanced options box. 

23. In SQL Server Management Studio, copy the query under Sales in the 1 - Charts.sql query. 

24. In Power BI Desktop, paste the query into the SQL Statement (optional, requires database) box, 
and then click OK. 

25. The data preview window will appear. Click Load. 

26. The window will close and return to the report. 

Add Visualizations to a Report in Power BI Desktop 

1. In the Fields pane, right-click Query1, click Rename, type Customers, and then press Enter. 

2. Right-click Query2, click Rename, type Sales, and then press Enter. Expand the two tables to display 
all the fields. 

3. In the Fields pane, under Sales, select the SubCategory, and OrderQty check boxes. Power BI 
creates a table. 

4. In the Visualizations pane, click Stacked column chart. 

5. Grab the expander on the right edge of the chart, and then widen the chart so that all category labels 
are visible.  

6. Ensure that the chart is still selected, and then in the Visualizations pane, click Analytics. 

7. Expand Constant Line, and click Add. 

8. In the Value box, type 100. 

9. Change the color to red. 

10. Toggle Data label to On. 
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11. Change the color to red to match the reference line. 

12. Click Format, and expand Title, in the Title Text box, type Orders by Sub Category, and then click 
Center to align to the center. 

13. In the Fields pane, click Sales. 

14. On the Modeling ribbon, click New Column. 

15. In the formula bar, type the following code: 

LineTotal = Sales[OrderQty] * Sales[ListPrice] 

16. On the Modeling ribbon, click Format: General, point to Currency, and then click $ English 
(United States). 

17. Click a blank area of the page. 

18. In the Fields pane, under Sales, select the Product check box, which adds a table, and then select the 
LineTotal check box. 

19. In the Visualizations pane, click Fields, under Filters, expand LineTotal(All). 

20. In the list, click is greater than, and in the box, type 25000. 

21. Click Apply filter, and then note that the number of products in the table is reduced.  

22. In the Visualizations pane, click Format, click Title, and change the Title slider to On. 

23. Under Title, in the Title Text box, type Product Sales Over $25k, and then click Center. 

24. Select the table, and then click Stacked bar chart.  

25. Use the expander to widen the chart to the same width as the column chart. 

26. On the chart, click More Options, and then click Sort By LineTotal. 

27. At the bottom of the window, click the + icon to add a new report.  

28. On the Home ribbon, click Manage Relationships, and then point out that Power BI has auto-
detected the relationship on the CustomerID columns, then click Close. 

29. In the Fields pane, expand Customers, and then select the City check box. Power BI automatically 
adds a map chart. Expand the map to show all countries.  

30. In the Fields pane, under Sales, select the LineTotal check box to add it to the map. Grab the right 
corner of the map, and then drag it to fill the whole of the report page. 

31. Zoom in on the map to focus on the UK. Point out that the bubbles now represent the sales for each 
customer, and are proportionately sized. Position the cursor over some of the bubbles to display the 
data labels. 

32. Save the file as Customer Sales, in the D:\Demofiles\Mod06\Demo folder.  

33. Leave Power BI open for the next demonstration. 
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Lesson 2 
Managing a Power BI Solution 
Contents: 
Question and Answers 7 
Demonstration: Creating Featured Questions 7 
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Question and Answers 
Question: Which of the following statements about the Manage Data portal is false? 

(   ) The portal enables you to manage your shared queries. 

(   ) You can edit and control access to your data sources in the portal. 

(   ) Using the portal enables you to delete data sources that you no longer need. 

(   ) The Usage Report shows how many times a dashboard was consumed in Power BI. 

(   ) The Usage Report displays the most active groups in Power BI. 

 Answer:  

 (   ) The portal enables you to manage your shared queries. 

 (   ) You can edit and control access to your data sources in the portal. 

 (√) Using the portal enables you to delete data sources that you no longer need. 

 (   ) The Usage Report shows how many times a dashboard was consumed in Power BI. 

 (   ) The Usage Report displays the most active groups in Power BI. 

Demonstration: Creating Featured Questions 

Demonstration Steps 
Add Featured Questions to a Dashboard 

1. Ensure that the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines are running, 
and then log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd. 

2. In Power BI Desktop, click Publish to publish the report you created in the previous demo. 

3. In the Power BI Desktop dialog box, enter the password for the account you used to sign up for the 
Power BI service, and click Sign in. 

4. In Internet Explorer, go to http://www.powerbi.com and click Sign in. 

5. Sign in using the credentials you used to sign up for Power BI service. 

6. In Power BI, click Show the navigation pane.  

7. Under Report, click Customer Sales. 

8. At the bottom of the page, click Page 1, click the Orders by Sub Category visual, and then click Pin 
visual. 

9. In the Pin to dashboard dialog box, click New dashboard, type Customer Sales, and then click Pin. 

10. Under Dashboards, click the ellipses (…) next to Customer Sales, and then click Settings. 

11. On the Dashboards tab, under Q&A, ensure the Show the Q&A search box on this dashboard 
check box is selected. 

12. On the Datasets tab, click Customer Sales. 

13. Under Settings for Customer Sales, click Featured Q&A Questions to expand the list. 

14. Click Add a question and in the text box, type Show sales by customer.  

15. Click Add a question, and in the text box, type Show all products with unit price greater than 
$250, and then click Apply.  
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Use Featured Questions 

1. Under Dashboards, click Customer Sales. 

2. Click Ask a question about your data, and the Featured Questions you have just added now appear 
at the top of the list of suggestions. 

3. Click the Show sales by customer question to see the results. 

4. Remove the question text, and then click the Show all products with unit price greater than $250 
question to see the results. 

5. Close Internet Explorer. 

6. In the Publishing to Power BI dialog box, click Got it. 

7. Close Power BI Desktop. 
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Module Review and Takeaways 
Question: Why do you think the Manage Data portal prevents you from deleting data sources? Do you 
agree with this, or should you be able to delete the data sources for the queries that you have shared? 

Answer: Deleting a data source creates problems because queries depend on data sources. In 
particular, if you were to delete a shared query and data source that colleagues are currently 
using, you would have the potential to break their reports. It could be professionally damaging if 
a data source was removed that a user depended on for a report that the business urgently 
required—and the user could not deliver the data in the expected timeframe. The Usage Report 
shows you which users are sharing your data sources and queries, so dependent users can be 
informed if the data source is to be removed by using Excel. The Manage Data portal is 
connected to the Lync system, so you can easily contact those users who are sharing your data 
sources and queries, if you want to use another method to delete them.        
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Lab Review Questions and Answers 
Lab: Creating a Power BI Report 

Question and Answers 

Lab Review 
Question: Discuss the tools that you used to shape and combine data in the labs. How did this compare 
to using Excel, or coding Transact-SQL to deliver the same results? Do you think it is quicker to use Power 
BI rather than the applications that you currently use? 

 Answer: Answers will depend on the opinions of the students. 

Question: Discuss some of the visualizations that you used in the optional exercise to create a report that 
was relevant for your organization. If you did not have time to do the optional exercise, which of the 
charts that you used in the lab will you reuse to create reports for your organization? Can you think of 
data that you can present by using the map charts? 

 Answer: Answers will depend on the opinions of the students. 
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Module 7 
Direct Connectivity 

Contents: 
Lesson 1: Cloud Data 2 

Module Review and Takeaways 5 

Lab Review Questions and Answers 6 
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Lesson 1 
Cloud Data 
Contents: 
Demonstration: Using Databases in Azure SQL Database As a Power BI Data Source 3 
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Demonstration: Using Databases in Azure SQL Database As a Power BI 
Data Source 

Demonstration Steps 
Import Data from Tables in a Database in Azure SQL Database 

1. Ensure that the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines are running, 
and then log on to 20778A-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd. 

2. On the taskbar, click Power BI Desktop. 

3. In the Power BI Desktop window, click Get Data.  

4. In the Get Data dialog box, click Microsoft Azure SQL Database, and then click Connect. 

5. In the SQL Server database window, in the Server box, type the URL of the Azure server <Server 
Name>.database.windows.net (where <Server Name> is the name of the server that you created). 

6. In the Database (optional) box, type AdventureWorksLT, and then click OK.  

7. In the SQL Server database dialog box, click Database. 

8. In the Username box, type Student. 

9. In the Password box, type Pa$$w0rd, and then click Connect. 

10. In the Navigator dialog box, select SalesLT.Customer, SalesLT.SalesOrderDetail, and 
SalesLT.SalesOrderHeader, and then click Load.  

11. In the Fields pane, notice that the three tables have been added. When the report is published to the 
Power BI service, the tables are combined into a single dataset. 

View Relationships Between the Tables 

1. In the menu of the left, click Relationships, and then expand the SalesLT SalesOrderDetail, SalesLT 
SalesOrderHeader, and SalesLT Customer tables to display all columns.  

2. Position the cursor on the relationship arrow between SalesLT SalesOrderDetail and SalesLT 
SalesOrderHeader. Notice that the related columns are highlighted. 

3. Position the cursor on the relationship arrow between SalesLT SalesOrderHeader and SalesLT 
Customer. Point out that the related columns are highlighted. 

4. In the menu of the left, click Report to return to the report canvas. 

5. Drag the CompanyName field from SalesLT Customer onto the canvas to create a table.  

6. Drag the LineTotal field from SalesLT SalesOrderDetail onto the Customers table on the report.  

7. In the Visualizations pane, click Stacked column chart. 

8. Drag the right edge of the chart to stretch it across the report and display the customers in full. 

9. In the Visualizations pane, click Format, expand Title, and then rename the chart Line Total by 
Company Name. 

10. Click on the canvas, and then drag the CompanyName field from SalesLT Customer onto the 
canvas to create a table below the chart.  

11. Drag the OrderQty field from SalesLT SalesOrderDetail onto the Customers table on the report.  

12. In the Visualizations pane, click Stacked column chart. 

13. Drag the right edge of the chart to stretch it across the report and display the customers in full. 
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14. In the Visualizations pane, click Format, expand Title, and then rename the chart Order Quantity 
by Company Name. 

15. Expand Data colors, and then select a different color from the Default color selector. 

16. Click on the canvas, drag the CompanyName field from SalesLT Customer onto Page level filters. 
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Module Review and Takeaways 
Question: Discuss the different ways in which your organization could use Power BI to connect to online 
data sources. What would be some of the potential benefits of direct connectivity to services such as 
Azure SQL Database? Are there any scenarios in your organization that could use the On-premises data 
gateway? 

Answer: Answers will vary depending on the students’ experience. 
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Lab Review Questions and Answers 
Lab: Direct Connectivity 

Question and Answers 

Lab Review 
Question: Discuss the different online data sources that your organization could use to create Power BI 
reports. Can you think of a scenario where users perhaps have Azure SQL database for one set of reports, 
and data in another online database for another set of reports? Could this be combined into a single 
dataset in Power BI? 

Answer: Answers will vary depending on the students’ experience. 

Question: Discuss the issues to consider when deciding whether to import data or use DirectQuery when 
building reports against large online databases. Ask students about their own organizations—ask them 
how they would make such a decision. 

Answer: Answers will vary depending on the students’ experience. 
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Module 8 
The Developer API 

Contents: 
Lesson 1: The Developer API 2 

Lesson 2: Custom Visuals 4 

Module Review and Takeaways 6 

Lab Review Questions and Answers 7 
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Lesson 1 
The Developer API 
Contents: 
Demonstration: Using the Developer API and Registering an App 3 
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Demonstration: Using the Developer API and Registering an App 

Demonstration Steps 
Using the Developer API in the Interactive Console: 

1. Start the MSL-TMG1, 20778A-MIA-DC, and 20778A-MIA-SQL virtual machines, and then log on to 
20778A-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. In Internet Explorer, go to http://docs.powerbi.apiary.io/. 

3. In the Dashboards - Preview section, click List all Dashboards. 

4. In the right console pane, describe the results that are now displayed, such as the GET URL, and the 
example Response body. 

5. In the right console pane, click Try. 

6. In the Authentication needed window, click Authenticate. 

7. In the Sign in to your account dialog box, enter the credentials you used to sign up for Power BI 
service, and then click Sign in. 

8. On the Apiary for Power BI page, click Accept. 

9. If the right console pane has not refreshed, click List all Dashboards. 

10. In the right console pane, click Call Resource. 

11. Scroll down to see the Response details in the console pane. 

Registering an App 

1. In Internet Explorer, go to http://dev.powerbi.com. 

2. Scroll down the page, and under Client app, click Register your app. 

3. In the Step 1 section, click Sign in with your existing account. 

4. Sign in using the credentials you used to sign up for Power BI service. 

5. In the Step 2 section, enter the following information: 

 App Name: Power BI Mobile Integration 

 App Type: Native app 

 Redirect URL: https://powerbiapp.contoso.com/gettoken 

6. In the Step 3 section, select all the APIs. 

7. In the Step 4 section, click Register App. 

8. In the Client ID box, select the text, and copy the string. 

9. Paste the text into Notepad; point out that this string would now be used in the app. 
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Lesson 2 
Custom Visuals 
Contents: 
Demonstration: Importing and Using a Custom Visual 5 
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Demonstration: Importing and Using a Custom Visual 

Demonstration Steps 
Import a Custom Visualization: 

1. In Internet Explorer, go to https://app.powerbi.com/visuals. 

2. In the Visuals library section, ensure that Custom visuals is selected, and then browse or search for 
Donut Chart. 

3. Click the Donut Chart visual, and then click Download Visual. 

4. In the license dialog box, click I agree. 

5. At the download prompt, click Save, and download the Donut Chart to a folder on your local 
machine. 

6. On the taskbar, click Power BI Desktop.  

7. In the Power BI Desktop window, click Open Other Reports. 

8. In the Open dialog box, browse to D:\Demofiles\Mod08\Demo, click Adventure Works 
Sales.pbix, and then click Open. 

9. In the Visualizations pane, click the ellipsis (…), and then click Import a custom visual. 

10. In the Caution: Import Custom Visual dialog box, click Import. 

11. In the Open dialog box, browse to the location where you saved the Donut Chart, click Donut 
Chart.x.x.x.pbiviz, and then click Open. 

12. In the Import Custom Visual dialog box, click OK. 

Use a Custom Visualization: 

1. In Power BI Desktop, in the Report view, at the bottom of the page, click the Company Report tab. 

2. Click the Line Total by Company Name visual. 

3. In the Visualizations pane, click the DonutChartGMO icon. Data that was previously displayed using 
the Clustered column chart should now be displayed in the Donut Chart visualization. 

4. Close Power BI Desktop, without saving any changes, and then close Internet Explorer. 
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Module Review and Takeaways 
Question: Discuss the potential of the Power BI Developer API for your own organization. Are there any 
particular Power BI-based applications that you already use, or would like to see developed? 

Answer: Answers will vary depending on the students’ experience. 
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Lab Review Questions and Answers 
Lab: Using the Developer API 

Question and Answers 

Lab Review 
Question: Do you think that the Sunburst visualization provides additional insights into the Sales Order 
data, compared with the clustered column chart that was originally used? 

Answer: Answers will vary depending on the students’ experience. 

Question: From your own experience, are there any other custom visuals from the Power BI visuals gallery 
that would add value to the Sales Order data? 

Answer: Answers will vary depending on the students’ experience. 
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Module 9 
Power BI Mobile 

Contents: 
Lesson 1: Power BI Mobile Apps 2 

Module Review and Takeaways 4 
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Lesson 1 
Power BI Mobile Apps 
Contents: 
Question and Answers 3 
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Question and Answers 
Question: If you have an iOS, Android, or Windows 10 phone or tablet, download the Power BI app if you 
don’t already have it. You do not need to sign in with a Power BI account, because you can use the 
sample data. However, an account will be needed for the lab. Users who do not have an account can 
create one using the following steps:  

Ensure that the 20778A-1-MIA-DC and 20778A-1-MIA-SQL virtual machines are both running, and then 
log on to 20778A-1-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

Open Internet Explorer from the taskbar, and browse to the Office 365 Trial sign-up page, and follow the 
instructions: http://aka.ms/Y682m2. 

Sign in to Power BI on your phone or tablet. 

Explore the features of the Power BI app, and look at the samples and demo server if these are available. 
Discuss useful features that could be added to improve the app, in addition to features you like and don’t 
like, and how they could be useful in your organization. 

Answer: Answers depend on the opinions of the students, based on the version of the app they 
download, and how they think Power BI mobile can benefit their workplace. 
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Module Review and Takeaways 
Question: Discuss the types of information that are likely to work best on a mobile device. Ask students 
how they think Power BI mobile apps could be used in their own organizations, and which types of 
visualizations and data formats they would choose for mobile reports and dashboards. 

 Answer: Answers will vary depending on the students’ experience. 
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